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Preface

This document contains release notes describing enhancements and repairs to this release of
Oracle Utilities Work & Asset Management. Items are sorted by subsystem and module, then by
Bug DB number.

Audience

These release notes are intended for anyone installing or using Oracle Utilities Work and Asset
Management Release 1.9.1.1.

Related Documents

For more information on this release, refer to the following related documentation. Please ensure
that you are using the appropriate guide based on whether you are installing on Windows or Linux
Application Server.

User Documentation
*  Oracle Utilities Work and Asset Management Configuration Guide for Release 1.9.1.1

*  Oracle Utilities Work and Asset Management Online Help for Release 1.9.1.1
*  Oracle Utilities Work and Asset Management User Guide for Release 1.9.1.1
*  Oracle Utilities Work and Asset Management Customization Guide for Release 1.9.1.1

Installation Documentation

About the Release
*  Oracle Utilities Work and Asset Management Quick Install Guide for Release 1.9.1.1

*  Oracle Utilities Work and Asset Management Release Notes Guide for Release 1.9.1.1

New Installations
*  Oracle Utilities Work and Asset Management Installation Guide for Release 1.9.1 on Linux OS
Application Server
New installation on WebLogic /Linux OS

*  Oracle Utilities Work and Asset Management Installation Guide for Release 1.9.1 on Windows OS
Application Server
New installation on WebLogic / Windows OS

Supporting Docs
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*  Oracle Weblogic Server:
http:/ /www.oracle.com/technetwork/middleware /weblogic/documentation/
index.html

*  Oracle® Fusion Middleware Installation Guide for Oracle WebLogic Server 11g Release 1
(10.3.6)

*  Oracle® Fusion Middleware Installation Guide for Oracle Portal, Forms, Reports and Discoverer
11g Release 1 (11.1.2)

* 6.5 Installation on Operating Systems Not Certified at the Time of Product Release:
http://docs.oracle.com/html/E18558_01/fusion_requirements.htm#BABCEFEA]

Conventions

The following text conventions are used in this document:

Convention Meaning

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a
paragraph, URLs, code in examples, text that
appears on the screen, or text that you enter.
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Supported Platforms and Hardware

Requirements

This section provides information regarding the operating systems and servers on which this

release has been tested and certified.

Supported Platforms

The installation has been certified to operate on many operating system, application server, and

database server combinations. See below for details on the browser, operating system and

application server combinations on which this release has been tested and certified. If you are

consulting this matrix in between releases (including service pack and patch releases), you should

contact customer support for the most up to date version.

Operating Chioset Application Database Client
System P Server Server Operating System
*AIX 5.3 (64-bit) TLL11 Power Not Supported Supported Windows XP x86 SP3
*AIX 6.1 (64-bit) TL4 64-bit Oracle (32-bit)
. . ] Database

Oracle Enterprise Linux 5.8 & x86_04 Weblogic Server versions Windows7 x86 SP1
64 10.3.6 include (64-bit and 32-bit)
(64‘b1t) Forms 1lg 11.1.21 10.2‘0'4,

' ) 11.1.0.7, Windows Vista x86**
Red Har Enterprise Linux 5.8 & and 11203, (64-bit and 32-bit)
6.4 ) Enterprise or
(64-bit) Standard Oracle Enterprise Linux
*Solaris 11 (64-bit) SPARC  Not Supported Edition. >4

(64-bit)

HP Itanium HPia 11.31 x86_64 Not Supported
Windows 2008 Server x86_064 Weblogic Server
Enterprise Edition R2 SP2 10.3.6

(64-bit)

Forms 11g 11.1.2.1

Note: Oracle Utilities Work and Asset Management discontinued support and releases of
applications on Oracle Application Server (OAS) in release 1.9.1 due to the de-support of this
platform by the Oracle Server Group as of December 2012.
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Client Operating System Specific

Browsers

Java

Internet Explorer 8.x (32-bit) - not supported on Linux client
Internet Explorer 9.x (32-bit) - not supported on Linux client
Internet Explorer 10 (32-bit) - Windows 7 only

Mozilla Firefox ESR (32-bit)

Java Virtual Machine Plug-in for Browser - Java Plug-in v1.6.0_39 (32-bit) and v1.7.0.45
(32-bit)

Application Server Specific

Java

JDBC Driver
11.2.0.2.0 (WebLogic)

Integrations

Barcode
e RFGenv3.2.1.28

¢ Loftware 9.5

GIS - ESRI ArcGIS 10.2

GIS - ESRI ArcIMS 10

GIS - ESRI ArcMAP 9.3

GIS - Oracle MapViewer 10.1.3.4

Microsoft Project 2007

Oracle Business Intelligence Publisher 11g Release 1 (11.1.1.6.0)
Oracle Business Intelligence v2.4.0

Oracle Integration Pack for Oracle Utilities Field Work 3.1
Primavera 8.3

Windows Mobile 6.5

VM Products

Notes

Oracle VM 2.2

Oracle VM may be used to create a virtual machine for either the database or application
server operating system. Refer to the Oracle VM Release 2.2 documentation for more
information about using Oracle VM.

Barcoding, Mobile, and Chart server add-on applications do not run on Linux. Please
refer to knowledge base article ID 1336258.1 on https://support.oracle.com for more
information.

Fine Grain Access functionality requires Enterprise Edition Database Server.

* If your database server is installed on AIX, HP or Solaris, please refer to the database
support document for these servers.

Support for Software Patches and Upgrades

Due to the ongoing nature of software improvement, outside vendors and other Oracle products

will issue patches and service packs for the operating systems, application servers and database
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servers on top of specific versions that Oracle Utilities Work and Asset Management has been
tested with. If it is necessary to apply an upgrade, please do that in a test environment prior to
updating the Oracle Utilities Work and Asset Management production environment.

Always contact Oracle support prior to applying vendor updates that do not guarantee backward

compatibility.
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Release Notes

These release notes contain the following sections:
e About This Release

. Known Issues

* Integration Information

¢  Fixes and Enhancements

About This Release

Refer to the quick install guide and upgrade guide for information regarding certifications,
supported platforms and installation steps.

Please visit My Oracle Support (http://support.oracle.com) for the most recent service packs
and/or patches for this release to ensure you have the most curtent version of this product.

11G Database Support
If you are upgraded to the Oracle Database 11g, a special script is required to allow email and
product integration URLs to be successful as in older versions of the database (8, 9i, 10g). Follow
the instructions in the Oracle Utilities Work and Asset Management Upgrade Installation Guide to meet
this requirement.

Please trefer to the Oracle 11g DBMS documentation located on support.oracle.com for more
details on how to restrict unwanted URLs.

Charts Server and Thumbnails
In Release 1.9.1, functionality to support chart thumbnails was removed due to Microsoft
desupport of XP Web Components. As a result, charts are still supported with the following
provisions:

*  Chart thumbnail generation of charts on the home page is no longer supported. This
functionality was replaced with static images that represent the chart graphic. Clicking
the static image launches the corresponding chart.

Office Web Components (required for thumbnail generation) are no longer supported
on 1IIS Servers since they cannot run on a 64-bit environment

*  Oracle Utilities Work and Asset Management uses XP Office Web Components to
display the main chart. This is available and downloaded from Microsoft.

*  Users can use existing charts, and can create new charts using Office XP or Office 2003.
Later versions of Office do not support these features.
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Oracle Forms Patches
If there are any Oracle Forms patches that need to be applied prior to upgrading, these are
indicated in the Known Issues section.

Previous Patches
If you have recently applied a patch, please review these notes carefully to verify that your patch is
included in this release. In rare cases, when a patch is requested close to the release date for the
next software distribution, there may not be time to include the patch content in the general
release. Functionality may be impacted if you apply a release that does not include a previously
deployed patch. Check with Customer Support to verify the status of a particular item.

Unwrapped Database Procedures
This release of Oracle Ultilities Work and Asset Management includes database procedures that are
no longer wrapped to encode the programs. This was provided to allow customers to better
understand the business logic that happens within various procedures so that it is easier to
integrate Oracle Utilities Work and Asset Management with other products. These procedures are
provided as a reference resource only. They should not be altered as they are an important part of
the Oracle Utilities Work and Asset Management Base application and changing them will cause
adverse affects to the application.

JAR File Certificate Information

Files (all files signed with the same certificate)
*  jacobjar
*  jspell2n_javall.jar

*  synergenpjcs.jar

*  synjar

Certificate Information

X.509, CN="Oracle America, Inc.", OU=Software Engineering, OU=Digital ID Class 3 - Java
Object Signing, O="Oracle America, Inc.", L=Redwood Shores, ST=California, C=US
[certificate is valid from 7/6/10 5:00 PM to 7/6/13 4:59 PM]

Integration Information

The following integrations are supported in this version of Oracle Utilities Work and Asset
Management:

Oracle Utilities Work and Asset Management Product Integrations
* Integration with Oracle Utilities Advanced Spatial Analytics, 2.4.1
Please refer to the documentation released with Oracle Utilities Advanced Spatial
Analytics for more information.

*  Oracle Integration Pack for Oracle Utilities Field Work 3.1
This integration can be downloaded on the Oracle Software Delivery Cloud. Select
Product Pack “Oracle Application Integration Architecture” then select “Oracle
Application Integration Architecture Release 3.1 Media Pack for Microsoft Windows”.

*  Oracle Utilities Work and Asset Management Integration to Primavera P6
Enterprise Project Portfolio Management
This integration can be downloaded on the Oracle Software Delivery Cloud. Select
Product Pack “Oracle Application Integration Architecture” then select “Oracle
Utilities Work and Asset Management Integration to Primavera P6 Enterprise Project
Portfolio Management Release V11.1.0.0.0 Media Pack”.
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Desupported Integrations

Known Issues

The Oracle Utilities Customer Care and Billing Integration to Oracle Utilities Work and Asset
Management is no longer supported. This legacy integration was deprecated with the release of
Oracle Utilities Customer Care and Billing 2.3.1 and Oracle Utilities Work and Asset Management
1.9 and was not certified with these versions.

Support continues for existing customers currently using or implementing this integration (i.e.
address product defects related to this legacy integration). However the integration will not be
enhanced or supported going forward therefore, we strongly discourage using this integration for
new implementations. Existing customers can continue to leverage the integration patterns that
were formerly delivered with the edge applications. However, please be advised that it will be
necessary to maintain these as custom interfaces when upgrading to newer versions of the
applications. Alternatively, customers can evaluate Oracle Integration Pack for Oracle Ultilities
Field Work, as the productized solution. The Field Work integration is generally more robust,
configurable, and extensible than the older integration.

This section describes known issues in Oracle Utilities Work and Asset Management Release
1.9.1.1 at the time of release. Fixes for these issues will be released as they become available.

Oracle 11G Database

*  11G databases contain user profile features not related to Oracle Utilities Work and
Asset Management that can still affect an Oracle Utilities Work and Asset Management
user's ability to log in.

If users experience problems logging in, one possible cause is that the 11G default
profile has an expiration of 180 days. Make sure that the PASSWORD_LIFE_TIME
setting for the applicable database profile is consistent with Oracle Utilities Work and
Asset Management password expiration settings.

Consult Oracle 11g Database documentation (available on my.oracle.support) for details.

General Browser Issues

Firefox

*  To support readability and accessibility compliance, style changes have been made to
specify a relative size rather than a fixed font in web browsers. This allows different text
elements to increase or decrease in size proportion based on generic web settings. In
some versions usets might see an increase in font size on some screens. To fix this issue,
adjust the zoom setting:

Internet Explorer: View > Zoom (set percentage as appropriate)

Fitefox: View > Zoom > Zoom Text Only then View > Zoom > Zoom In/Out (as
needed)

*  Unable to launch the Entity Relationship Viewer. The viewer requires XSLT processing
that Firefox is unable to perform. If the user attempts to upgrade Firefox using the
recommended XML installer from Microsoft, the installer does not run.

*  Right-click context menus do not function. These are the menus specific to Oracle
Utilities Work and Asset Management, not standard right-click functionality.

*  There is no Effects option for graphs.

*  Dialog windows show a URL box which should not be visible. This was purposefully
hidden in Internet Explorer.
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If you find that fonts do not appear sharp in Firefox try the following fix with Windows
ClearType to improve the clarity.

http://risingline.com/blog/smoother-firefox-fonts-windows-xp.php

Summary of Steps

1. Minimize all your windows and right click anywhere on your desktop.

2. Select Properties then choose the Appearance tab then click the Effects button.

3. Make sure the check mark is in the box next to "Use the following method to
smooth edges of screen fonts:" and select ClearType. Then click OK.

There are slight differences in font display and size as well as differences in appearance
for some portions of some components. Selecting the ClearType option as described
above can also help to minimize this issue.

The View Document action in Document module does not work for files which are
stored on a shared network folder and whose storage type is ‘File System’. This is due to
a security restriction that prevents Firefox from loading such files. The workaround for
this issue is to manually enter the file path in Firefox’s address bar in order to load the
file.

Internet Explorer

In IE 8, when new browser windows are opened from forms, they may appear behind
the current window. For example, when opening Advanced Options windows, Export
Results of Search, or opening Online Help the newly opened window may not
automatically appear in the forefront of the screen.

IE 8 and IE 7 security features prevent charts from opening. There are 2 settings that
can be changed to work around this issue. One setting is to allow the chart to run, and
the second setting is to disable the warning dialogs. It is recommended that these
changes are limited to trusted sites or the local intranet:

1. In Internet Explorer select Tools > Internet Options.
2. Select the Security tab.

3. Click the Custom Level button.

4

Under Miscellaneous - "Access data sources across domains' -- set to Enable
instead of prompt (prompts are the warning dialogs).

5. Under User Authentication, Logon - "Automatic logon with current user name and
password" -- set to "Automatic logon with current user name and password."

Windows 7 Client

The Webutil components do not download automatically to a Windows 7 client. This is a
known issue of the Oracle Application Server team but there is no patch to push the
correct DLLs. This is related to new security in Windows 7 and Vista.

On Windows 7 client machines, DLL files required to run Webutil functions may not
download to the client machine. This is a known issued caused by security features in
Windows 7 and Vista operating systems. You can work around this issue by configuring
Webutil to download the required DLL files into a directory that is not restricted. By
default, the directory will be the uset's home directory, but you can choose a specific
path. This configuration change will be used for all client machines accessing the OC4]J
instance.

Within the webutil.cfg file, make sure the following setting is available.

install.syslib.location.client.0
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Web Services

The default value will be the uset's home directory on the client machine. On Windows 7
client machines, this is usually "\ Users\username", where "username" is the Window's 7
username currently logged in. You can determine what the user's home directory is by

HS"

issuing the command "s" within the Java Plug-in Java Console and looking for the

"user.home" setting.

Setting the "install.syslib.location.client.0" value to a relative path (not including the
drive), will write to a directory relative to the user's home directory. For example, you can
use "install.syslib.location.client.0=webutil", and this will add the DLL files to

"\ Users\username\webutil".

Reference the document titled, "How To Change The Default Download Directory For
Forms WebUtil Client Files" [ID 783937.1] located on http://support.oracle.com for
instructions and additional information.

A conversion error occurs on Axis based web services when the web service attempts to
convert date ot time values. This occurs because of bugs in eatlier versions of the JDBC
driver. The default JDBC Driver for Oracle Application Server is 10.1.0.5.0 and this is
where the error typically happens. You must use version 10.2.0.4.0 or above.

Java Runtime Environment 1.6.0.24 or higher

Linux Client

Report Engine

After upgrading JRE to version 1.6.0.24 or higher, you may encounter security
exceptions while viewing or printing attachments in Oracle Utilities Work and Asset
Management. This error occurs because on JRE v1.6.0.24 or higher, webutils will not
access UNC file path names. You can resolve the issue by updating all Document module
recotds and Links/News that have UNC path names to reference a server file path or a
URL.

To ensure that mouse focus works properly on Linux client, you must modify the
basewam.html file to delayTime=1000 and delayTries=5. These additional settings in the
file are meant for specific environments that require further delays to allow Java and
Forms to load before a Forms request is made. By default, there is minimum to no delay.

Different desktop screen resolutions affect the Forms applet font sizes and placement of
items on canvases. The recommended screen resolution on a Linux client is 1280 x 1024.

The following features which require client-side file manipulation do not currently
function on a Linux client:

1. Viewing, Uploading, Downloading and Printing documents and attachments
2. Using RFQ Import/Export wizard features

3. Launching third-party applications that are not web-based applications (MS project
integration, GIS non-web-based vendor integrations etc)

4. Using Operational Data Wizard features

These features require an enhancement which will be delivered in a later release.

Report jobs randomly failing with error: REP-300/501.

The problem happens for reports started via forms/run_report_object or using “rwservlet”
with desformat PDF, destype cache or file. After the first reports job has crashed, all

following jobs of any kind return with error REP-501, so the engine cannot connect to the

database again until the reports server is restarted or engLife is accessed and the engine is

restarted.
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Please refer to Document ID: 1270315.1 on my.oracle.support.com for more information.

Report Builder

Reports Builder fails when attempting to run it from the Start menu. No error is displayed,
only an MS-DOS window flashes quickly then nothing else happens.

Please refer to Document ID: 1509064.1 on my.oracle.support.com for more information.

Error When Opening PLL Forms After Installation
FRM-40735 and ORA-06508 errors raised when you exit from a Called Form with attached
libraries.

Please refer to Document ID: 1170133.1 on my.oracle.support.com for more information.

Fixes and Enhancements

This section describes bug fixes and enhancements in Oracle Utilities Work and Asset
Management Release 1.9.1.1 at the time of release. Please refer to the list of fixes and
enhancements on the next page.
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1.9.1.1 Release Notes

-
E
4

Indicates an enhancement

v Checked items may require configuration following installation.

Prior Parent
Bug DB# Module Description Rel Bug#
Purchasing
16955499  Invoicing, Fixed the following LOV to include Vendor Location on Vendor Name 1.9.1.0.1 16803284
Requisition to PO column when VENDOR OPTIONS Business Rule - VENDOR NAME =
wizard VENDORLOC
- Invoice's PO Number
- Requisition to PO's Vendor Code
16588875 Invoicing User can now filter search with Blanket Contract number. 19.1.01 16204115
16709764 Purchase Order When copying existing Purchase Order, the current tax rates from 19.1.01 16681971
code tables are now being used.
16773899 Requisition Fixed Work Order list of value in Requisition Line Item view to include 1.9.1.0.1 16773853
Approved Work Orders.
16858465 Requisition Fixed Approval Logs being deleted when Requisition is set to
Canceled status.
12409931 Invoice Batch job no longer creates a record in Storeroom Transaction Log
when Invoice Price is different from the PO.
16231836 Cost Adjustment Added business rule that will turn ON or OFF the overriding of the
account number for Work Order/Asset line item.
14406759 Requisition Ii Added options to allow the user to decide whether or not to copy
notes and attachments when copying a requisition. This added Copy
Notes and Copy Attachments checkboxes in the Copy Requisition
Wizard.
14407195 Cost Adjustment v~ Added UDFs to Cost Adjustment Header and Line Items.
16588930 Purchase Order Updated the Purchase Order > Invoice List and Invoice > Discrepancy 1.9.1.0.1 14228403
Invoice Log to display the correct status "Pending Resolution" when the
Invoice is in "Pending Resolution": status.
7119495 Requisition Added Account validation to approval of a Requisition that was
created using Copy Record action or a Purchase Order that was
created using Split/Add to PO action.
16562243 Invoicing Modified form pre-insert processing to ensure the F6/F4 duplication ~ 1.9.0.4.9 16312954
resets the PRORATE_IND to N in SA_INVOICE when an invoice
header is duplicated from either an Approved or Posted invoice.
17336063 Purchase Order Fixed error encountered while trying to launch Purchase Order
module.
17549487 Request for Quotes Fixed next item navigation error after choosing value for UDFs.
13019835 Requisition/Purchase Order | Updated processing so that when a requisition or purchase order is
copied using Copy Record, the system uses the most current unit
price and other details from line item storeroom records rather than
using possibly outdated information from the existing purchasing
record.
16949814 Warranty Fixed error in Warranty Claim Wizard, can now successfully create
Warranty Claim from wizard.
16588930 Purchase Order Updated the Purchase Order > Invoice List and Invoice > Discrepancy 1.9.1.0.1 14228403
Invoice Log to display the correct status "Pending Resolution" when the
Invoice is in "Pending Resolution": status.
16809505 Change Order
Fixed the status of Change Order line item generated from Create
Change Order action in Purchase Order module. When PO item is in
Canceled status, the Change Order item should also be in Canceled
status. Otherwise it will be defaulted to Created status.
17270290 Service Invoice Corrected the select statement used at service invoice approval to 1.9.0.4.10 17068506

create multiple service invoice account line items when the same
account exists on different work order tasks on the same service
invoice line item.

Fixes and Enhancements
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Bug DB# Module

14406790 Purchase Order, Requisition,
Change Order

Maintenance
16672542 Timesheets

12805637 Work Order
16217746 Work Order Task

16955506 Work Order
Benchmark Work Order
16739203 PM Master

6605341 Work Order Task

17270365 Work History

16915651 Work Order Task, Work
Order, Bench WO, Fleet WO,
Fleet Bench WO

13068449 Permit

16757555 Work Request

17609580 Operational Schedule
17044471 Schedule Plan

17074489 Work Planning Portal
17036566 Metadata /
Daily Schedule
Workweek Schedule
Schedule Plan

v

=~

a

Prior
Description Rel

Warn user entering line items in Requisition, Change Order or
Purchase Order with "Document Total exceeds Limit Amount of the
Blanket Contract." when it will exceed the Blanket Contract Limit.

Added 'Check BPO Limit', which can be set to ON or OFF in
Purchasing Options Business Rule.

When posting Timesheets, Wage Rate is now being pulled from the  1.9.1.0.1
Timesheet record for each record if both rule keys on Labor Costing

Wage Rages business rule are set to NO.

Added cancellation reason when cancelling work order.

Corrected help message shown when a work order task status has
been changed from Planning to Rejected.
Fixed continuous scrolling in Task summary view.

Updated the Labor Est. vs. Actuals view to include a separate table to 1.9.1.0.1
display all unplanned labor not on the Benchmark Task Labor

Requirements detail which was charged against Work Order Tasks

generated from a PM Master associated to the Benchmark.

Changed processing so that work order tasks cannot be canceled if
they have associated child records. An active work order task cannot
be canceled if related pending records exist in checkout request, cost
adjustment, direct charges, invoice, purchase order, requisition, or
timesheet.

Fixed error encountered in generating Custom Work Order History
Report.

In the Task Material Item detail, clear Type when Stock Code is
cleared.

On Actual Qualifications view, when selecting Employee via LOV,
hitting save and then proceeding to the next line to create a new
record, the error "You have not saved your changes! Save or Undo
before leaving." is no longer encountered.

Fixed Work Request attachments to be copied when creating Work
Order from Work Request.

Fixed duplicate column name error when saving a new record.

Reflect Field localization of label on Work Planning Tool.

Removed Daily Scheduled Date and Weekly Scheduled Date on 19.0.44
Results of Search.

Added "Work Category" and "Work Class" to the Add Task from Work 1.9.0.1.1
Order wizards for all schedule types.

17044488 Work History I Modified selection screen to add Backlog and Report Codes fields.
This fields together with Work Priority, Required Date, Crew and Work
Description already have the ability to search in task levels.
17044478 Work Order Task I Added Reported By and Reported Date in the Task (Detail) view of
Work Order Work Order Task, Work Order, Benchmark Work Order, Fleet Work
Benchmark Work Order Order, Fleet Benchmark Work Order and Work History modules to
Fleet Work Order identify the person and the date when the incident was reported. Both
Fleet Benchmark Work Order fields are also present in the selection screen of Work Order Task.
Work History System can now search task using this filters.
16098915 Work Order Task Closeout Modified the closeout process so existing rows in the Work Order >
Task Failure Summary are not overwritten from the Task Closeout
Wizard when the Task is set to Finished status.
16749714 Work Order Task i Added Project / Subproject to the Work Order Task module selection

screen.

Parent
Bug#

16672537

16224454

13739934

16828612
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Bug DB#

Resource
16737936

16740544
16562497

17237395

16405384

17045072
16600728

17044435
17284589

16453544

17044450
17621853

16709598

17317528

16900140

17706508

Module

Storeroom
Bill of Materials
Document Control

Change Request

Function

Asset
Work Order
Work History

Operational Tolerances
Specification Template

Document Control

Asset Operational Data

Procedure

Asset,
Asset Inspection

Regulatory Accounts

Asset Class,
Asset Inspection

Change Request

Prior
Description Rel

On Storeroom Work Demand view, Status for Checkout Request now 1.9.1.0.1
use status from Checkout Request header.
Made 'View' button for documents linked to the Bill of Materials
available under Drawing Documents View.

1.9.1.01
Fixed hanging of system when saving a created Document Control
Missing error message have been inserted. Correct message are now
displayed when changing Change Request status for
Catalog/Storeroom type from Created to Pending Approval

Fixed error encountered when Copy Record is used in Function, with
Asset setup to be system-generated and Function user-inputted.
Fixed Asset Downtime Summary report to display all entries for
downtime of the retrieved asset

Rejected has been added to the Approval Log of the Work Order as a
valid approval status.

Increased DATA_READING field precision to 5 digits.

In SELECTION screen:

Renamed LOV SPECIFICATION_TYPE_SELECTION to
SPECIFICATION_TYPE_SEL

Renamed Record Group SPECIFICATION_TYPE to
SPECIFICATION_TYPE_SEL.

Renamed Record Group SPECIFICATION_CATEGORY_MODE to
SPECIFICATION_SELECTION

Added a checkbox for Revision Control Indicator in the Create
Document wizard for the user to set the value to eithera 'Y or N.

v~ Added User Defined Fields.

Fixed Where Used view to appear in procedure regardless of whether
format is Step or Document.

Updated asset condition scoring calculation to correctly factor
weighted averaging for condition inspections by inspection category
and type.

Updated the unique index on the table:
SA_REGULATORY_ACCOUNT_OH_COST to include the column
OVERHEAD_CLASS and ALLOCATION_TYPE.

1.9.0.11

1.9.0.4.10

The index should include the following columns:

("PLANT", "REGULATORY_ACCOUNT_NO",
"REGULATORY_ACCOUNT_TYPE", "OVERHEAD_ACCOUNT_NO",
"OVERHEAD_ACCOUNT_TYPE", "PERIOD_YEAR",
"WORK_ORDER_NO", "WORK_ORDER_TASK_NO",
"EXPENSE_CATEGORY", "PERIOD_MONTH",
"ALLOCATION_TYPE", "OVERHEAD_CLASS")

19.1.01

Modified the Asset Class and Asset Inspection forms to increase the
size of the fields INSPECTION_CRITERIA_DESC and
INSPECTION_ATTRIBUTE_DESC to 400 characters.

The column inspection_attribute_desc in the table
sa_asset_class_insp_attributes is now defined as VARCHAR2(400)

The column inspection_criteria_desc in the table
sa_asset_class_insp_criteria is now defined as VARCHAR?2(400)

Fixed hanging on Change Request Asset (Change) view.
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|

16371552

15962545

16673035

17317278

16709581



Prior Parent

Bug DB# Module Description Rel Bug#
_________________________________________________________________________________________
17485098 Asset The error "Oracle ERROR: unable to perform query ORA-28110:

policy function or package
XADMIN_SYNERGEN.SDBP_APP_SECURITY has errors" is no
longer encountered when opening Work History view.

Inventory

17375731 Multi-Step Receiving Fixed error encountered when receiving quantity in MSR where stock
code involved requires Quality Control.

16822152 Physical Inventory Fixed uncontrolled scrolling in the stock code item list.

17313234 Receiving Fixed Packing Slip not being enforced as a required field in Receiving
wizard.

17044741 Stock Checkout Custom Reports on Custom Menu is now being filtered correctly with

the Primary Keys assigned on Modules Admin Forms.

System Administration

16935303 Report Administration Display an error when Select Block does not exist in Report 1.9.1.0.1 14740093
Subsystem Location.

17346607 Bl Publisher Integration Updated SIA build to include all files required to support the 1.9.0.4.9 16824794
integration to Bl Publisher 11g.

17036517 Report Administration 1.9.1.0.1 16312620

Fixed error encountered when generating through Reports
Administration a Bl Publisher 11G Report.

Removed outdated instructions from the Customization guide and
provided reference to documentation on how to convert Oracle
Reports to Bl Publisher.

Please refer to the document titled: "Oracle Business Intelligence
Publisher Converting Oracle Reports to Oracle Business Intelligence
Publisher" available on the Oracle Technology Network
(http://mww.oracle.com/technetwork/middleware/bi-publisher/e28918-
01-1602839.pdf) or contact support for more information.

17207393 Report Administration Enable generation of Bl Publisher report in Excel Format by setting
WEB CONFIGURATION Business Rule's REPORTS DEFAULT
OUTPUT FORMAT to EXCEL.

16311758 Business Rule Increased the length of code table key value to 30 and column to 186
to be able to display the full texts from the Code Table as LOV values.

16286111 Report Administration Display full Reports Option window.
17309803

17327970 Job Manager v A new database procedure, sdbp_clnup_incrct_srvinc_chrgs, has 19044

been created to allow for clean-up of any incorrectly posted Service

Invoice charges to the wrong Work Order Task. An individual job

manager record must be created for each Service Contract which

may have the incorrect service invoice charges posted to Work Order

Tasks. The format for the job manager is:

sdbp_clnup_incrct_srvinc_chrgs(job number, 'plant’,

'service_contract_no');
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Prior Parent

Bug DB# Module Description Rel Bug#
I
16724775 Job Manager 1. Updated SDBP_WORK_ORDER.FIXED_ASSET to remove the 1.9.1.0.1 16617886
Business Rule allocated overhead distributions from the work in progress (WIP)
Database account when the work order is in 'Closed' status.

2. PLANT_IN has been added to the where clause for the cursor
C_RECEIVERS in the procedure
SDBP_YEAR_END_OH_COST_DIST.

3. BR: REGULATORY ACCT OVERHEAD CLASS: The LOV for
USE_QUERY_KEY_VALUES3 now includes GLOBAL.PLANT and
KEY_DESC desc in SQL select and where clause.

4. Added PERIOD_MONTH as a primekey to
PK_SA_REGULATORY_ACCT_OH_COST unique index in the table
SA_REGULATORY_ACCT_OH_COST.

17044421 Forms Administration The table column FMEA_SYSTEM_CODE has been added to forms
administration for the header block on Asset and Asset PM Control
Module.

17236660 Report Administration Changed the title of the S_RPTO071 to Work Order Forecast Report.

Fixed the report to display the work order task where crew is based on
PM Master's lead crew if it is not null and based on the benchmark if
PM Master lead crew is null.

16362652 Batch Stock Reorder Fixed error when running batch sdbp_stock_reorder.stock_reorder
Requisition due to buyer length is greater than the length of Requestor field in the
Purchase Order PO/Requisition created. Buyer name length is truncated to 30

characters before inserting it to Requisition/PO.

16709857 Business Rule v~ Anew business rule has been added: ASSET INSPECTION DATA.
ASSET INSPECTION DATA This new rule establishes a default aging factor value to be used to
calculate the confidence factor found on the Asset when inspections
are done if no age range is defined for the Weighting Category in the
Aging Factors module. The value must be between .01 and 1.00.

System Wide
12805691 System Wide I Allow users to set preferences/defaults for Export to Screen to File
functionality. Export Type default can now be set to either HTML,
TEXT or XLS.
17087752,  Work Design, Purchase Included views that have nhames other than the blocks in the Blocks
17244079 Order, Permit LOV in the Responsibilities module to allow users flexibility in hiding
more views.
14798917 Work Request I Increased Description for Work Request and Document Control to
Document Control 300.
16967433 Reports / Bl v~ rpt_list.fmb - Removed the contents of PRE_INSERT trigger to allow 1.9.1.0.1 16356901

insert of blank SELECT_BLOCK_LOCATION

saipsuin.pll - Modified the library to handle blank
SELECT_BLOCK_LOCATION and report type = Bl Publisher.

A new window will open pointing to the Bl Publisher web application
and the report selected.

Verify settings in the Web Configuration business rule:
REPORTS CUSTOM VIRT DIRECTORY must be set with the
appropriate directory URL.

Example: http://[server]/reports/rwserviet

Bl 11G Host must be set with the appropriate value.
Example: http://[server]/xmlpserver/

16462554 Inbox Fixed wrong insertion in sender and recipient's inbox and sent box
when sending/forwarding search, bookmark and link. Message is how
displayed in the correct folder.

17733395 Daily Scheduling Fixed error encountered when launching list of values for Work
Workweek Scheduling Category and Work Class fields in Add Task from Work Orders
action.
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Prior Parent

Bug DB# Module Description Rel Bug#

16012616 Login v/ Modified main.fmb to support Single Sign On for WebLogic.
SIA settings need to be configured to fully support Single Sign On.
Please refer to the configuration guide chapter titled "General System
Setup" for instructions.

16934697 Spell Check 1.9.0.1.1 16813855
formspell.war has been added to the installation package for V1.9.1.1

16524707 Internet Explorer V10.x Microsoft Internet Explorer V10.x running in Windows y is now
supported in WAM V1.9.1.1.

Customer

16815195 Service Request Ii Fixed Asset List View to display and asterisk when a Service Request
is associated to an Asset.

Barcode

14613403 RFGen
Updated the procedure sdbp_rfgen_print to support 11g reports.

12801311 RFGen Added the following additional details to PO Receiving: PO quantity,
net quantity received, current received, and the remaining line item to
be received.

14613394 RFGen User is given an option to print Issue ticket after checkout/return
transactions on Rugen.

12684818 RFGen On Receiving, Packing Slip is now being defaulted to the previously
entered value.

14621586 RFGen Updated the procedure sdbp_rfgen_print to support direct print of
reports from RFGen barcode.

Reports

8292697 S_RPT113 Tag Points / Sources to be Isolated is now displayed on Permit
Lockout/Tagout Report.

14407166 S_RPT206 I Unit price of all items in blanket contract report are now displayed in
consistent decimal format.

Interface

16166711 Meter interface Use v_max_meter_dials when input is zero or NULL and removed the
NOT EQUAL to zero condition when computing for rollover value.
Changed format mask of all current and life to date meter reading
fields to display field max length which is 99,999,999.99.

SIA Portal

13372373 Approval Portal Fixed drilldown of Storeroom on Change Order, Purchase Order and
Requisition, it now opens the correct record on the Storeroom
module.

16828348 Chart Administration Fixed error when performing spell check.

GIS Portal

16857144 GIS - Asset Import Removed the code which raises the application error to allow
alphanumeric values to be saved in street_number_char field.

10637278 GIS configuration 2 Attributes added to <map> element assetIiDLabel and assetField.
The assetField is the field name within the GIS data and the
assetIDLabel is what is displayed in the viewer Ul

16562231 ESRIArcGIS 10.2 v ESRI ArcGIS 10.2 is certified for use on WAM V1.9.1.1

Bl Extracts

16562625 Business Filtered F_ WRKORD_TK_EXT extract to include records in Finished 1.9.0.4.8 16311946

Intelligence and Closed status only.
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Prior Parent

Bug DB# Module Description Rel Bug#
Scripting
17061119 Install Shield v/ WAM V1.9.1.1. Install Shield no longer restricts the repcache folder
name during the installation process.
13931474 Upgrade Scripting Modified installation / upgrade scripts to not overwrite the ESRI GIS

configuration files.
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